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Notices
Copyright Notice
© Keysight Technologies 2004–2023

No part of this document may be repro-
duced in any form or by any means (includ-
ing electronic storage and retrieval or
translation into a foreign language) without
prior agreement and written consent from
Keysight Technologies, Inc. as governed by
United States and international copyright
laws.

Warranty
The material contained in this document is
provided “as is,” and is subject to being
changed, without notice, in future editions.
Further, to the maximum extent permitted
by applicable law, Keysight disclaims all war-
ranties, either express or implied, with
regard to this manual and any information
contained herein, including but not limited
to the implied warranties of merchantability
and fitness for a particular purpose.
Keysight shall not be liable for errors or for
incidental or consequential damages in con-
nection with the furnishing, use, or per-
formance of this document or of any
information contained herein. Should
Keysight and the user have a separate writ-
ten agreement with warranty terms cov-
ering the material in this document that
conflict with these terms, the warranty
terms in the separate agreement shall con-
trol.

Technology Licenses
The hardware and/or software described in
this document are furnished under a license
and may be used or copied only in accord-
ance with the terms of such license.

U.S. Government Rights
The Software is "commercial computer soft-
ware," as defined by Federal Acquisition
Regulation ("FAR") 2.101. Pursuant to FAR
12.212 and 27.405-3 and Department of
Defense FAR Supplement ("DFARS")
227.7202, the U.S. government acquires
commercial computer software under the
same terms by which the software is cus-
tomarily provided to the public. Accordingly,

Keysight provides the Software to U.S. gov-
ernment customers under its standard com-
mercial license, which is embodied in its End
User License Agreement (EULA), a copy of
which can be found at http://www.key-
sight.com/find/sweula. The license set forth
in the EULA represents the exclusive author-
ity by which the U.S. government may use,
modify, distribute, or disclose the Software.
The EULA and the license set forth therein,
does not require or permit, among other
things, that Keysight: (1) Furnish technical
information related to commercial com-
puter software or commercial computer
software documentation that is not cus-
tomarily provided to the public; or (2) Relin-
quish to, or otherwise provide, the
government rights in excess of these rights
customarily provided to the public to use,
modify, reproduce, release, perform, dis-
play, or disclose commercial computer soft-
ware or commercial computer software
documentation. No additional government
requirements beyond those set forth in the
EULA shall apply, except to the extent that
those terms, rights, or licenses are explicitly
required from all providers of commercial
computer software pursuant to the FAR and
the DFARS and are set forth specifically in
writing elsewhere in the EULA. Keysight
shall be under no obligation to update,
revise or otherwise modify the Software.
With respect to any technical data as
defined by FAR 2.101, pursuant to FAR
12.211 and 27.404.2 and DFARS 227.7102,
the U.S. government acquires no greater
than Limited Rights as defined in FAR
27.401 or DFAR 227.7103-5 (c), as applic-
able in any technical data. 52.227-14 (June
1987) or DFAR 252.227-7015 (b)(2) (Novem-
ber 1995), as applicable in any technical
data.
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Contacting Us

Keysight headquarters
1400 Fountaingrove Parkway
Santa Rosa, CA 95403-1738
www.ixiacom.com/contact/info

Support

Global Support +1 818 595 2599 support@ixiacom.com

Regional and local support contacts:

APAC Support +91 80 4939 6410 support@ixiacom.com

Australia +61-742434942 support@ixiacom.com

EMEA Support +40 21 301 5699 support-emea@ixiacom.com

Greater China Region +400 898 0598 support-china@ixiacom.com

Hong Kong +852-30084465 support@ixiacom.com

India Office +91 80 4939 6410 support-india@ixiacom.com

Japan Head Office +81 3 5326 1980 support-japan@ixiacom.com

Korea Office +82 2 3461 0095 support-korea@ixiacom.com

Singapore Office +65-6215-7700 support@ixiacom.com

Taiwan (local toll-free number) 00801856991 support@ixiacom.com
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About this Guide
This section contains information that explains the typographical conventions used in this
documentation. This information will aid you in using the documentation most effectively. Also
provided is a list of related documentation that you may find useful.

In this section:

Conventions 7

Related Documentation 8
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Conventions
The following typographical conventions are used in this documentation:

l Italics are used to indicate the names of software fields and parameters, titles of books or
documents, and first references to words, terms, phrases, or concepts that have a special
meaning or require special identification or emphasis. For example:
n In the userid field, enter your assigned user identification number.
n Norton’s Telecom Dictionary is a helpful reference tool.
n The term tolerance level refers to the standard deviation setting.
n The variable n represents any numerical value.

l Menu names and options appear as bold blue text in online Help, and appear in small capital
letters in documents. For example:
n To save your input, choose the File>Save menu option.

l Bold black type is used to indicate the names of buttons, commands, and files that are part of
procedures, as well as to identify field and parameter options. In addition, bold text emphasizes
important information in text or in caution, warning, or danger statements. For example:
n To proceed to the next step, click OK.
n Use the copy command to duplicate the field entry.
n Save and close the books.xml file.
n Always save your test configuration.

l Courier text is used to indicate typed text input. For example:
n Access the new file name at the command line: c = newbook.gif.

n Enter the setup.ini location: setupini = Ixia\Code\New.

l PC keys are indicated in all caps, using the following conventions:
n Simultaneous keystrokes are shown by joining the key names with a plus sign (+), For
example, CTRL+Q.

n Sequential keystrokes are shown by joining the key names with a comma (,). For example,
SHIFT, F7.

The following table describes the note icons and messages used in this document.

Name Icon Description

Note Indicates information that emphasizes or supplements
important points in the main text.

Important Indicates information that is essential to the completion of a
task.

Tip Provides supplemental suggestions for applying techniques and
procedures to accomplish a task.

About this Guide
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Related Documentation
The following documentation may be helpful in gaining more understanding of IxLoad. The
documentation is available from the Help pull-down menu in IxLoad or from the IxLoad CD.

IxLoad user documentation is also available from https://support.ixiacom.com. User registration is
required to view this online documentation.

l IxLoad User Guide (online help)
l IxLoad on Linux User Guide
l IxLoad Voice Test Library Reference Guide
l IxLoad REST API Programming Guide
l IxLoad for AWS Getting Started Guide
l IxLoad Tcl API Programming Guide

About this Guide
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Getting Started with IxLoad on legacy platforms
If you are new to IxLoad, you can follow the procedures in this Getting Started guide to run a simple
test and quickly gain experience with IxLoad. If you need to do more advanced testing, you should
refer to the IxLoad User Guide.

In this section:

Requirements 10

Step 1: Install IxLoad 11

Installing IxLoad 12

Step 2: Connect the test ports 15

Step 3: Extract the Sample Repository 16

Step 4: Start IxLoad and Open the Sample Repository 17

Step 5: View the Client and Server Networks 18

Step 6: Display the Server and Client Traffic 21

Step 7: View the Timeline and Objectives 24

Step 8: Select Ports for the Test 27

Step 9: Start the Test 29

Step 10: View the Test Results 30

StatViewer 30

PDF Report 30

CSV Files 32

Step 11: Save the Test Configuration 33

Further Testing with IxLoad 34

Adding Page Requests to the HTTP Client 34

Adding FTP Traffic 36
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Requirements
To run the IxLoad tests in this guide, you need the following:

l A chassis with a load module that supports IxLoad (see the release notes for the current list)
l Two ports available on the load module
l A loopback (cross-over) cable or layer 2 switch
l A PC with a supported version of Windows installed. For the current list of supported Windows
versions, see the release notes.

Getting Started with IxLoad on legacy platforms
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Step 1: Install IxLoad
IxLoad is available for download on Keysight’s website (https://support.ixiacom.com/support-
overview/product-support/downloads-updates).

There are several different installers for IxLoad:

l IxLoad_<version>.exe: Installs the IxLoad client.
l IxLoadChassis_<version>.exe: Installs the IxLoad components that must run on the Ixia
chassis.

l IxLoadMediaClips_<version>.exe: Installs the sample video files to be used for testing video
performance.

l Other installers that install components required by IxLoad that perform specific functions.

In the current release of the application, the IxLoad installer does not contain
any software prerequisites, such as the .NET framework or SQL Server Express,
that are required for the IxLoad application to run. If the PC you are installing
IxLoad on does not have the prerequisite software already installed, during the
installation process you will be prompted to provide a location for any of the
missing prerequisites. You then have the option of specifying a path on the local
host (if you have them available as a kit stored on your host), or you can choose
to download them from the http://www.ixiacom.com/support/downloads_and_
updates/prerequisites page on the Keysight website.

You must install IxLoad in two locations:

l on the PC where you will run IxLoad
l on the chassis that you will use to generate IxLoad traffic

On the chassis, you must install IxOS before you install IxLoad. The IxOS components that IxLoad
requires are installed by default when you install IxOS; you do not have to select any optional
components during the IxOS installation. Refer to the IxLoad release notes for the specific version of
IxOS that this release of IxLoad requires.

The PC that you will use for the IxLoad client should have at least a 1.8GHz P4 CPU, 1GB of RAM, and
a screen resolution of 1024x768. The PC must have one of the versions of Windows listed under
Requirements.

As part of the installation procedure, you will be asked to register IxLoad. You should ensure that you
have your IxLoad licenses ready before you begin installation. If you are unfamiliar with the product
licensing process, see IxLoad Licenses.

You can install multiple versions of IxLoad on the client and on the chassis. For
information on using multiple versions of IxLoad, see the IxLoad User Guide.

To install IxLoad, see Installing IxLoad.

Getting Started with IxLoad on legacy platforms
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Installing IxLoad
In addition to a conventional attended installation, IxLoad can be installed
silently. See Silent Installation.

Prerequisites Required for Installation

IxLoad requires certain third-party components to be installed such as Microsoft DotNet 4 and
Microsoft SQL Server 2014 SP1.

If you are installing from a DVD, these components are located under a folder named prerequisites
in the root of the DVD. The installer will automatically locate and install the required components.

If the installer cannot automatically find the components under the prerequisites folder, it prompts
you to choose how to find the components:

l Automatically download... allows the installation to download the required components from
Keysight's website. This is the recommended option.

l Browse enables you to specify the directory where the components are located. If an Internet
connection is not available on the PC on which you are installing IxLoad, you can download the
components to another computer, share the location, and browse to that location.

To install IxLoad:

1. On a PC or Ixia chassis, login under an account that includes Administrator privileges. If you run
the installation from an account that does not have Administrator privileges, the installer
displays the following error message:
Error installing ikernel.exe (0xa00)

2. The IxLoad installer consists of multiple files:
l The installer and first part of the file repository: IxLoad_<version>_EA.exe (or EB.exe)
l The remaining parts of the repository: IxLoad_<version>_EA.partX (or EB.partX)

All these files must be in the same directory.

3. Double-click the installer .exe file to start the installation.

Getting Started with IxLoad on legacy platforms
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The installation is a typical InstallShield installation; respond to the prompts as the installer
displays them in the windows.

4. The PC installer offers a choice of Typical Setup or Custom Setup. Custom Setup allows you to
install several optional components:

User Documentation Installs the user documents that are supplied as PDFs. If you
do not select this option, only the User Guide (the online
help) will be installed.

IxCatapult Installs the IxCatapult LTE-UE plugin.

Published Vulnerabilities
and Malware

Installs the PVM plugin.

Samples Installs a zip archive containing sample repositories (.rxf
files) and supporting files.

IxLoad Gateway Installs the IxLoad Gateway, a component required for using
the IxLoad REST API.

5. Click Finish to complete the IxLoad installation.
Remember to install IxLoad on the remaining system (chassis or PC) before you start to use it.

Getting Started with IxLoad on legacy platforms
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Silent Installation

In addition to a conventional attended installation, IxLoad can be installed silently.

Client Installation

To install the IxLoad client components silently:

1. Open a console window and set the path to the directory containing the IxLoad client .exe file.

2. Extract the installer using the following command:
IxLoad<version>.exe /s /extract-only

Example: IxLoad6.70EB.exe /s /extract-only

The installation files are extracted to the following location:
\Program Files\IxiaInstallerCache\IxLoad\x.x.x.x where x.x.x.x is the build number.

3. Change the path to the directory where the installer files were extracted to.

4. Start the silent setup with the following command:
setup.exe -s CannedConfig=Full

Chassis Installation

To install the IxLoad chassis components silently:

1. On the chassis, open a console window and set the path to the directory containing the IxLoad
chassis .exe file.

2. Extract the installer using the following command:
IxLoadChassis<version>.exe /s /extract-only

Example: IxLoadChassis6.70EB.exe /s /extract-only

The installation files are extracted to the following location:
\Program Files\IxiaInstallerCache\IxLoad\x.x.x.x where x.x.x.x is the build number.

3. Change the path to the directory where the installer files were extracted to.

4. Start the silent setup with the following command:
setup.exe -s

Getting Started with IxLoad on legacy platforms
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Step 2: Connect the test ports
To run the tests described in this guide, you can use either of two test topologies:

l Test ports connected to a Layer 2 switch.
l Test ports connected directly to each other (back-to-back).

The figure below shows both topologies. Connecting the test ports to a DUT would create a realistic
test scenario and results; connecting the test ports directly to each other is simpler. Either one will
work for the purpose of getting to know IxLoad.

To connect the test ports:

1. Choose the scenario you want to use, and then connect the test ports.

2. On the IxLoad client PC, test your connection to the chassis by using the Ping command to ping
the management port on the chassis.

On an XM12 chassis, the management port is on the front of the chassis. On all
other chassis, it is on the rear.

Getting Started with IxLoad on legacy platforms
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Step 3: Extract the Sample Repository
IxLoad includes a zip file named samples.zip that contains a large number of sample repositories.
You can use the repositories in samples.zip to familiarize yourself with IxLoad, or you can use them
as templates for creating your own repositories.

To perform the test described in this guide, you use a repository in samples.zip named
simpleHTTP.rxf. simpleHTTP.rxf contains most of the elements required to run a basic HTTP test.

To extract simpleHTTP.rxf:

1. Start Windows Explorer, and browse to the following directory:
<installPath>\Ixia\IxLoad\<version>\

2. Open the samples.zip file, and extract the simpleHTTP.rxf file.

Getting Started with IxLoad on legacy platforms
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Step 4: Start IxLoad and Open the Sample Repository
Before you start IxLoad:

l Make sure IxServer is running on the chassis. IxServer normally starts automatically when
Windows starts or when a user logs on.

l Make sure that you know which ports are available on the chassis. Other Keysight applications
such as IxExplorer, IxAutomate, and Tcl scripts allow users to take ownership of ports on the
Ixia chassis. If IxLoad tries to use a port owned by another user, it will not be able to run the
test.

To start IxLoad and open the sample repository:

1. Double-click the IxLoad icon (shown below).

IxLoad’s main window displays. IxLoad automatically logs you on using the local network name
configured on your PC. When you select test ports for your test, IxLoad will use this name to
identify those ports as being reserved for your exclusive use.

2. On the File tab, click Open Repository.

3. Browse to the location where you extracted the simpleHTTP.rxf repository.
IxLoad opens simpleHTTP.rxf.

4. Select the Test Overview node to display an overview of the test.

Getting Started with IxLoad on legacy platforms
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Step 5: View the Client and Server Networks
In IxLoad, a network determines the addresses of the hosts and their network configuration. An
IxLoad network consists of simulated subnets residing on one or more test ports. For most
applications that you plan to use IxLoad for, you can think of networks as simulating LANs containing
either clients or servers.

The simpleHTTP.rxf repository includes client and server networks you can use for your testing. You
can accept the default entries for these networks or change them if necessary.

To view the default client and server networks:

1. In the Test Configuration node, select the client nettraffic (as shown below).

2. In the client nettraffic, select Client Network.
When you select Client Network, the area to the right of the Test Configuration node contains
the elements that define the properties of the network.
For example, the IP element defines the IP address ranges that will be used on the network. The
IP element defines the IP addresses to be used.

3. Click each element to see the ranges that are configured.
For the network in simpleHTTP.rxf, there is one range of IP addresses and one range of MAC
addresses (see figure below). There is a range of VLAN tags configured, but they are disabled
and will not be used in this test .
Click each of the tabs if you want to view the parameters configured for them.

Getting Started with IxLoad on legacy platforms
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4. To view the server network, select the server network in the repository tree (see figure below).

5. Select Servers.

As with the client network, the tabs to the right display the network parameters that define the server
network. The figure below shows how the network controls correspond to the test topology.

Getting Started with IxLoad on legacy platforms
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Step 6: Display the Server and Client Traffic
In IxLoad, traffic is generated by Activities. An Activity defines the non-network properties of a traffic
stream, such as its protocol, its role in the connection (client or server), and the functions it
performs, such as executing commands (for an HTTP client) or serving pages (for an HTTP server).

SimpleHTTP.rxf includes one client activity and one server activity. The client activity simulates a web
browser and the server activity simulates a web server.

To display the server and client Activities:

1. In the Server column of the Scenario Editor, click the HTTP server activity.
The tabs on the bottom half of the window contain the controls used to configure the HTTP
server activity.

2. Click the Web Pages tab.
The Web Pages tab lists HTML pages that the IxLoad HTTP server will offer.

Getting Started with IxLoad on legacy platforms
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3. Select the HTTP client to display the HTTP client NetTraffic, then click the HTTP Client activity.

In the area to the right of the Navigation Tree, the tabs that define the client HTTP activity
display. These tabs define the attributes and functionality of the client HTTP activity.

4. Click the Commands tab.
The Command List is the list of commands that the client will execute. For the default client
activity in simpleHTTP.rxf, the command list contains one command, a GET that retrieves a 4-
kilobyte HTML page from the HTTP server activity.

Getting Started with IxLoad on legacy platforms
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Step 7: View the Timeline and Objectives
In this step, you view the test timeline and objective.

To view the test setup:

1. In the Test Configuration tree, click the Timelines and Objectives branch (see figure below).

The windows on this branch display the timeline (the timing of events that occur during the test,
such as when the simulated users and HTTP server are brought online) and the Test Objective.
The Test Objective is the type of goal that the test attempts to reach. For simpleHTTP.rxf, the
default Test Objective is Simulated Users, meaning that the test will attempt to simulate some
number of HTTP users using web browsers.
The Objective Value is the numerical goal for the Test Objective. For simpleHTTP.rxf, the
Objective Value is 100. Combined with the Simulated Users test objective, this means that the
test will attempt to simulate 100 web browsers active at one time.
The figure below shows how the test objective relates to the actions of the client and server in
simpleHTTP.rxf.

Getting Started with IxLoad on legacy platforms
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The Timelines tab (shown below) in the lower portion of the window contains the controls that
determine the point during the test when clients and servers begin to come online, the rate at
which they come up (Ramp Up), the length of time they stay up (Sustain Time), and the rate at
which clients go offline (Ramp Down).

2. For the Timelines tab, accept the default values configured in simpleHTTP.rxf.

Getting Started with IxLoad on legacy platforms
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Step 8: Select Ports for the Test
In this step, you select the ports that you will use for the test and assign them to the client and server
networks.

To select ports for the test:

1. Select the Ports node.

2. Click the Add Chassis button.
IxLoad adds a new entry to the Chassis Chain.

3. In the new entry, type the IP address or host name of the chassis.
IxLoad connects to the chassis and adds it and its ports to the Chassis Chain. The Chassis Chain
list displays only the cards that support IxLoad.

4. In the Chassis Chain pane, click one of the ports, drag it into the Assigned Ports pane, and drop

Getting Started with IxLoad on legacy platforms
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it on one of the traffic-network mappings. Repeat for the remaining traffic-network mapping.

Getting Started with IxLoad on legacy platforms
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Step 9: Start the Test
At this point, the test is ready to run. The only remaining configuration task depends on your IxLoad
license:

To start the test:

1. In the toolbar, click the Home tab.

2. Click Start Test.

IxLoad downloads the test configuration to the ports and then starts the test.

Getting Started with IxLoad on legacy platforms
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Step 10: View the Test Results
IxLoad displays the test results in three ways:

l In real time during the test, using StatViewer.
l After the test completes, in a PDF-format report.
l After the test completes, in a CSV file.

StatViewer

After the test starts, IxLoad automatically switches to the Statistics view, which displays the statistics
from the test (Figure 35). IxLoad uses a separate application named StatViewer to display the real-
time test statistics. When you start a test, IxLoad automatically starts StatViewer.

You can use StatViewer to select the statistics that display, to define the way that they display, to
analyze and compare statistics, and many other functions. For information on using StatViewer, see
the StatViewer User Guide.

PDF Report

After the test ends, IxLoad generates a PDF-format report that contains a summary of the test
results.

Getting Started with IxLoad on legacy platforms
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CSV Files

After a test ends, IxLoad also stores test statistics in comma-separated values (.csv) files.

The test results are available from the location defined on the User Directories window. See User
Directories.

Each time you run a test, IxLoad creates a new directory to store the CSV and log files in; it names
the directory based on the repository name, test configuration, date and time of the test, and the
activity model and network group used. For example, the format for the client-side file is:

C:\Program Files\Ixia\IxLoad\<version>\Results\<repository>_<test configuration>_
<yyyy><mm><dd>_<hh><mm><ss>

An example of an actual file is:

C:\Program Files\Ixia\IxLoad\<version>\Results\simple_HTTP_Test1_20050124_
101412\HTTP_Client_-_Default_CSV_Logs_http10_HTTP_client@client_network.csv

Getting Started with IxLoad on legacy platforms
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Step 11: Save the Test Configuration
If you want to save the test configuration and port assignments you used in the preceding steps, you
should save the simpleHTTP.rxf repository with a new name.

To save the test configuration:

1. Click the File tab.

2. Select File | Save As.
IxLoad prompts you to enter a name for the test configuration.

3. Enter a name for the repository, then click Save.

Getting Started with IxLoad on legacy platforms
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Further Testing with IxLoad
This section contains additional sample tests that will further familiarize you with IxLoad. These tests
make use of the IxLoad test configuration (the ports you selected while using the simpleHTTP.rxf
repository) created in the previous section. If you did not save that configuration, follow the steps in
the previous section re-create it.

The first test described in this section adds more page requests to the existing HTTP client.

The second test adds FTP traffic to the HTTP traffic in the original test configuration.

Adding Page Requests to the HTTP Client

In this section, you add more page requests to the existing HTTP client.

To add page requests to the HTTP client:

1. In the Test Configuration tree, select the HTTP client activity.

2. Click the Commands tab.

Getting Started with IxLoad on legacy platforms
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3. Hover the cursor over the Command list until the Add button displays.

4. In the list of Available Commands, select GET, then click Add.
IxLoad adds the GET to the command list.

5. Select the command, as follows:

Destination: Select HTTP server_HTTPServer1:80, the HTTP server activity.

Page/Object: Select any of the pages listed.

Abort: Leave this set to the default, None.

NameValue Args: Leave this field blank.

6. Optionally, you can click Add again and configure additional GET commands.

7. Run the test as described in Step 8: Start the Test.

8. Follow the steps in Step 9: View the Test Results and compare the results with those from the
original test using the one-page GET.

Getting Started with IxLoad on legacy platforms
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Adding FTP Traffic

This section describes how to add FTP traffic to the existing HTTP traffic.

To add FTP traffic to the test:

1. In the Test Configuration tree, select the HTTP server activity.

2. Hover the cursor over the Activity list of the HTTP server NetTraffic, then click Add to add a new
activity.

3. Select FTP Server from the list of activities.

Getting Started with IxLoad on legacy platforms
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IxLoad adds a new FTP Server Activity to the HTTP server.

4. In the Test Configuration tree, select the Client activity.

5. In the Activity list of the client NetTraffic, hover the cursor over the over the NetTRaffic until the
Add button displays, then click Add to add a new activity.

Getting Started with IxLoad on legacy platforms
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6. Select FTP Client from the list of Activities.

IxLoad adds a new FTP Client activity to the HTTP client (as shown below).

7. In the NetTraffic, select the FTP client, then click the Command tab.

8. In the Command list, click Add to add a new command.

9. In the list of Available Commands, select {Get}, then click Add.
IxLoad adds a new {Get} command to the FTP client's command list.
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10. Configure the command parameters as follows:

User Name: Enter a user name or leave this field set to its default.

Password: Enter a password (an SMTP email address) or leave this field set to its
default.

Destination: Select HTTP server_FTPServer:21, the activity that contains the FTP
server agent you added in the previous steps.

Arguments: Leave this field set to its default.

11. Click Start Test to start the test.

12. Monitor the test progress and compare the results for the new test configuration that includes
FTP traffic with those for the previous test that only included HTTP traffic.
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Getting Started with IxLoad on the APS-M1010/APS-
ONE-100
1. Follow the instructions on how to setup and configure the APS platform with IxLoad in the APS-

M1010/APS-ONE-100 Platform for IxLoad Installation Guide.

2. Continue with Step 1: Install IxLoad on page 11in this guide.

Getting Started with IxLoad on the APS-M1010/APS-ONE-100
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IxLoad Licenses
IxLoad is a licensed product. You do not need a license to configure a test, but you do need one to
run a test. The license must cover the protocols that you have configured for the test. Before IxLoad
starts a test, it checks for the presence of a valid license. If you do not have a license for IxLoad,
contact Keysight Sales (see page ii) or your Keysight sales representative.

The licenses for legacy chassis and the APS-M1010 chassis are different:

l Legacy chassis: Licenses are perpetual and node-locked to a specific chassis.
l APS-M1010: Licenses are floating perpetual per compute node, node-locked to a controller.

IxLoad licenses for APS-M1010 chassis
On the APS-M1010 chassis, you use the KCOS command line interface (CLI) to configure the license
for IxLoad.

For information on using the KCOS CLI, see the APS-100/400GE Series Platform KCOS Command
Line Interface (CLI) Reference Guide.

IxLoad licenses for legacy chassis
On a legacy chassis, IxLoad's default behavior is to check for a license on the chassis selected for the
test. If your license for IxLoad is installed on a different host, use the procedure described in the
IxLoad User Guide to define the license server.

This section describes the two most common scenario for installing (activating) a license on a legacy
chassis: online activation and offline activation.

l Online activation means that the IxLoad PC that will use the license is connected to the
Internet and can reach the activation server (the host that holds the license). If the PC can
access the internet, it should be able to this method.

l Offline activation means that the IxLoad host that will use the license is not connected to the
Internet or cannot reach the activation server. For example, a host in a secure lab that where
Internet access is blocked will have to use offline activation.

If you need more information, the processes for installing and managing licenses are described in
the Licensing Management User Guide.
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Online Activation

To install a license, you use the Ixia Licensing Utility (ILU), which is installed automatically when you
install IxLoad.

Before you begin:

l To install a license,you need an activation code, which is sent in an email when you purchase a
license.

l Licenses are stored on license servers, which can be an Ixia chassis or another host on the
network. You need to know the hostname or IP address of your license server to activate a
license.

1. Start the Ixia Licensing Utility. To start the ILU, click:
Start | All Programs | Ixia | LicenseServerPlus | Ixia Licensing Utility

2. In the License Server IP/Host Name field, select the host name or IP address of the license
server that holds the license you want to activate. If it is not in the list, enter its IP address or
host name.

3. Click Activate License.
The Activate License window displays.

IxLoad Licenses
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4. In the Activation Code field, enter the activation code from the email message.

5. In the Quantity field, the number of licenses you want to activate.
The Quantity value you enter must be the new total number of licenses activated for the
specified code, including those licenses that have already been activated previously.
For example, if an activation code has 6 licenses already activated and you want to activate 3
more licenses, you would specify 9 for Quantity (6 previous + 3 new = 9 total licenses).

6. Click Activate.
The license is now available for use on the chassis or workstation. If it is a single node-locked
license, it can only be used on that particular chassis or workstation.

Offline Activation

Offline activation is required when the PC that will use the license does not have access to the
Internet or to the Ixia chassis where the Ixia Licensing Utility (ILU) is installed. As a solution to this
limitation, you can generate the license file from a computer with Internet connection and then
transfer the file (using a USB stick, shared network location, or similar means) to the computer or
Ixia chassis where the ILU is installed. When imported into the ILU, the license file activates the
license.

Offline activation is a 2-stage process:

1. Generate the license file from a computer with Internet access.

2. Import the license file onto the PC that will use the license.

Ensure that you can complete both stages within 48 hours because the license file is only valid for 48
hours.

Before you begin:

l To install a license,you need an activation code, which is sent in an email when you purchase a
license.

l You need to know the hostname or IP address of the Ixia chassis or other host where the ILU is
installed.

l Ensure that you know how many licenses have already been activated for the activation code,
and how many remain (you can use the ILU on the Ixia chassis to find out).
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Stage 1: Generate the license file

To generate the license file:

1. On a PC that has Internet access, open the following page in a web browser: 
https://fulfillment-prod.ixiacom.com/activation

2. In the Host ID field, enter the Host ID of the computer or Ixia chassis where the ILU is
installed.

3. In the Activation Codes and License Quantities field, enter the activation code from the
email and the number of licenses you want to activate for that code. Use the following syntax:
<ActivationCode>, <LicenseQuantity>

You can perform offline activation for multiple codes at once by placing each code and quantity
on a separate line:
<ActivationCode1>, <LicenseQuantity1>

<ActivationCode2>, <LicenseQuantity2>

...

For the License Quantity, the value you enter must be the new total number of licenses
activated for the specified code, including those licenses that have already been activated
previously.
For example, if an activation code has 6 licenses already activated and you want to activate 3
more licenses, you would specify 9 for License Quantity (6 previous + 3 new = 9 total licenses).

4. Click Activate.
The system generates the license file in .bin format, prompting you to open or save it.

5. Save the license file in the required location and then transfer it to the computer or Ixia chassis
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where the ILU is installed.
The license file is valid for 48 hours. After that, you cannot use it to activate licenses.

Stage 2: Import the license file

To import the license file:

1. On the Ixia chassis or the computer where ILU is installed, click Start | All Programs | Ixia |
LicenseServerPlus | Ixia Licensing Utility.
The Ixia Licensing Utility application displays.

2. In the ribbon, click Offline De/Activation.
The Offline De/Activation window opens.
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3. Click Import License, then browse to the location where the license file is stored, and select it.

4. Click Finish to complete the import.

The license is now available for use on the chassis or your computer. If it is a single node-locked
license, it can only be used on that particular chassis or computer.

IxLoad Licenses
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